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For researchers working with LCMS data in the field of metabolomics, a common task is to quantify the masses
found within a certain retention time window. Such an analysis can be unexpectedly difficult in instrument
vendor software, especially when the list of masses is long or the number of samples large. MS Scan is a plugin
for Mnova Gears that has been developed to solve this problem, it automatically extracts mass spectra and
corresponding chromatograms from a batch of TIC (total ion current) files. The software:

- reads a TIC from an input document

- extracts up to three mass spectra in the previously set Retention Time ranges

- itthenreads the peaks, extracts the chromatograms, and quantifies peaks for each of the masses that
pass the specified threshold.

MS Scan generates automatic reports with results that can be easily reviewed and edited via the Mgears
viewer.

This document is intended to help you configure and run a typical MS Scan analysis. For more details about
Mgears options, please refer to the Mgears manual.

So, let’s get you started!

1. The Workflow

Before starting your analysis, go to Mnova File > Preferences > Mass to configure the mass analysis
preferences. MS Scan creates quite a lot of graphics, so it is highly recommended to save the Mnova results
with the minimum possible “weight”.

To do so, in the General tab > Saving Options, check the Item Only option to save the minimum data required.

@ Q Preferences ? *
@ P2l e Y @

Import  patabase NMR Mass Molecule  Scripting  Drawing Tools  Publications

General Plug-ins

Recent

= General i
= Save Setup Import Verify

a G Saving Options Crosshairs Behavior:
- S
® Ttem Only
1B Export to PDF...
\p7am & Dataset Data Compression + Live Mass Spectrum Preview
Save To Your choice will affect only to newly imported items.
Scales Behavior: Isotope Cluster Selection

& Open.. /. Fit to Height After Zoom )
= o Directc Minimum Intensity Ratio: 0.0100
= Upen Directory... + Synchronized Chromatogram's Time Scale

Open From Maximum Distance: 10.000 Da

| Relative Masses Visibility

s Print...
it | Page Setup...

Help
®) Preferences...
Advanced Plug-ins.=

OK = Load... Cancel

.,
g
L
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In the Setup tab, uncheck the Open TAC option to avoid opening the PDA total absorbance chromatogram at
the top of each document.

© Preferences ? X
s " ‘ .
= o B 4
O [ & ) ‘) 1A s
General  Plug-ins  'MPOt  Database NMR Mass Molecule  Scripting  Drawing Tools  Publications

General Import Verify

~Open TAC
\ Oy
Se\.ﬁb\mhld\ data to show when loading a new mass item

b JERNAL

oy
3

4 4| | P

OK Save v Load... Cancel

Now launch Mgears from the Tools ribbon.

(o b:l N MestReNova MASS

Home View Molecule Prediction Data Analysis Database Verification Elucidation Chemometrics Tools Analysis Quantitation

o & \ N Doy < ” —=

VAl —3E] A —) (- B9

® Yy iEE & W | |E ¥ S g =
Chemical Shift  Edit Run t Import Export Report aded NMR | Mgears |Mgears MyGears MyGears Reaction Mnova Mnova  View Mnova
Perturbation ~ Script = Script v Script - - - pt Tools « Viewer Workflows Monitorings Screen 1H Screen 19F Screen Result

Binding Scripts Script Tools Mgears Reaction Monitoring Screen
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The MS Scan analysis follows the general Mgears workflow based on the five-step setup.

1.1. Input

First, in the Input tab, select the data files for analysis by Mgears. Input files can come from Disk directories,
a database (DB), or from Real-Time acquisition. These modes are detailed in the Mnova Gears manual.

In this guide, we will use data from a Disk directory. So, in the Disk section, click on '~ and choose the
directory from which your MS data files will be retrieved.

%4 Mnova Gears ? X

E‘ Input j‘tf Processing i‘%{ Plugins 3 Design l ‘ Output ¢ Settings

i Automatic Detection | i = Experiments Selection =
@ Main Directory: C:/Users/Usuario/Desktop/Datasets/TIC
onal Directory:

Use the Automatic Detection mode, with which Mgears will use the saved masks to find experiment files.

'*'31; Mnova Gears

E Input J"QC Processing ieé; Plugins E] Design * Output =

g Qﬁutomatic Detection ;g Experiments Selection

@ Main Directory: C:/Users/Usuario/Desktop/Datasets/TIC
Optional Directory:

Wateh out! Your dataset masks (“MSD1.MS” in this example) must be correctly configured to be recognized
by Mgears. Go the Settings tab and click on the Mask Manager button to view current masks. If your file mask
is not entered, you can simply type it and click on OK to save the changes.

E‘ Input )"Q’ Processing ﬁj Plugins % Design 3 Output ¢ Settings

General

Retry on Error Opening Dataset ﬁ
i i ?
+/| Autoresume on Critical Error (Not Available in O 0 Masks For Automatic Detection ) X
Allow Events
Auto Attach Traces NMR: fid, ser, *.jdf, *.mnova, *.exp
Verbose Log Raw NMR: 1r, 2rr
Ecet | egLoMs: [_FUNC001.DAT, FISBEMS; analysis.baf, _FU -
Debug Mode (Execute All Process in Foregrour |~ Chromatography:
Debug Log UV/IR/Raman/Fluorescence: |*.jdx, *.spa, *.spc
CSV Separator ;  ~ Structures: *.mol, *.sdf
Notifications Bak to Default
oK Cancel
” Resume :E Load Settings g:' Save Settings m Import Settings ﬁ Export Settings @ Cancel o Run
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M

Going back to the Input section, you can click on Experiments Selection and check the GC/LC/MS experiment
type to avoid Mgears attempting to recognize and analyze other types of experiment files.

QQ Mnova Gears

| input j‘ef Processing

i%’i Plugins i Design [ *Outpu( ﬁ' Settings

g Q Automatic Detection :E Experiments Selection

@ Main Directory:
Optional Directory:

=1

NMR
1H

[2]Real Time

Advanced Options

Master File:

NOESY

| GC/LC/MS Chromatography

C:/Users{Usuario/Desktop/Datasets/TIC

HSQC | | HMBC
H2BC cosy
UV/IR/Raman/Fluorescence Mnova Documents

Allow More than One Experiment of Each Type Join Folders with Similar Name

Experiment Selection Mode:
Preview Subset Only | 1000

17 Filtering String:
Filter | Mapping File:

FID From: 31 Dec 1969 v | To:
=11 | Regular Expression to Adapt Match [

&)

Regular Expression Filter by Name Only
/| Substring Matching ¥

If needed, configure the Advanced Options or use the Filtering Options to refine the detection of your input

data files.

Top Tip! Before moving to the next step, you can use the Automatic inspection button @ to check if the
detected experiments correspond to your selection criteria.

1.2. Processing

Qﬁ Experiments Found: 2 ?
List of detected experiments: a
Experiment: SMPL1
MS: C:/Users/Usuario/Desktop/Datasets/ TIC/SMPL1/MSD1.MS
Experiment: SMPL2
MS: C:/Users/Usuariof/Desktop/Datasets/ TIC/SMPL2/msd1.ms
oK Cancel

In the Processing tab, you can upload a processing script to apply your own customized processing settings
(please refer to the Mnova Gears manual for more details about this option).
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1.3. Plugins

In the Plugins tab, select and add the MS Scan plugin.

S Mnova Gears ? X

{I Input }‘E’ Processing i%‘l' Plugins =t‘ Design B Output ﬁ Settings
&5 saa SN

i""-' Verify Add
i’_ﬁ Concentration {

- . Remove
N# Purity +

=

." DB Search ot
N# SMA Custom Plugin
8@ QC Profiling —

e . Delete
N9 Multiplet Report Custom Plugin
IUPAC Name i%j
1 MS Scan MS Scan
. Vs Plugin Settings

W@ Peak Report

&7 Mpublish

i""ﬁ B2ADF Converter

&# MS Reaction Optimisation

»Resume 3 Load Settings t Save Settings m Import Settings ﬁ Export Settings @ Cancel ° Run

The added plugin will appear on the right-hand side of the dialog. You should now click on MS Scan Plugin
Settings to configure the Analysis and Output parameters.

% Mnova Gears ? X
B Input ft" Processing i:;f‘l Plugins @ Design u Qutput n-Settings

N saA = > $% MS Scan
&g Verify Add

i;‘ﬁ Concentration ‘

- Remove

N@ Purity +

=

N DB Search -~

¥ SMA Custom Plugin

%@ QC Profiling -

— i Delete
&# Multiplet Report G
IUPAC Name =

MS Scan N&

MS Scan

u@ Peak Report Plugin Settings

r

&# Mpublish

N B2ADF Converter
&# MS Reaction Optimisation

-

T mme s . mm .

PP resume & Load Settings I+ Save Settings m Import Settings ﬁ Export Settings @cancel °Run
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A Settings dialog will appear. In the Analysis tab, you should choose the mass spectrum Retention time (RT)
ranges from which you want to extract chromatograms. You can enter up to three RT ranges.

You should also define the Minimum Relative Abundance % for the Mass spectrum extraction.

You can then choose the Tolerance and Minimum Area Threshold for the peaks of the mass chromatogram

extraction.

0& Settings

Analysis Qutput
Mass Spectrum Extraction

v RT from: 1.00 - to: |3.00 -~ | min
min Minimum Relative Abundance: 5% -

| RT from: 3.00 - to: 5.00 -
RT from: 10.00 < to: 15.00 ~| min

Mass Chromatogram Extraction

Tolerance: |0.250 < Da - Minimum Area Threshold:  10.00 % ~

OK Cancel

In the Output tab, you can configure the variables to display in the CSV and HTML result files that will be
automatically generated by Mgears. The RT, m/z, and Total Relative Area of the peaks are included in the
reports by default, whereas other parameters, such as Relative area, peak Height, etc., are entirely optional.

bﬁ Settings ? b
Analysis Output
v| RT | Rel Area (%) | Rel Height (%)
V| mfz /| Area (Abs) Scan
| Total Rel Area (%) Height (Abs) Start/End Time
OK Cancel

1.4. Design

In the Design tab, you can upload an Mnova layout templates or a Script to produce a final customized report.

QQ Mnova Gears ? X

# Jmput S Processing K Plugins B) pesign [ = output ﬂ- Settings

l\/ Apply Layout Template to All Pages
5 —

| Layout Template: |C:fUsers/Usuario/Desktop/Datasets/MS Scan template.mnova

Script:

Advanced
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1.5. Output

In the Output tab, click on | | and choose a directory in which to save your analysis results.

% Mnova Gears ? X

l:) |Input J'OL" Processing i&ﬁ Plugins B Design 3 Output a'Seliings

sk
| Directory: C:/Users/Usuario/Desktop/Results/MS Scan Yﬁ

As for all Mgears plugins, you can also choose to create an Mnova or PDF document with your results and save
your results to a connected DB.

2. The output folder

The results folder, which is named according to the date and time at which your analysis was run, is saved
under the directory specified previously. This folder contains all the output generated in the current
evaluation.

Results » MS Scan » |2021-03-12T09.59.15

A

Name
css
data
documents
images
js
pdf
| 2021-03-12T09.59.15
| 2021-03-12T09.59.15.resume
G MSScanResults
89 MSScanResults_SMPLT
39 MSScanResults_ SMPL2

| settings.mgrs
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MS Scan results and analysis parameters are reported:

Tolerance [Da]

0.25
m/z [Da]
537.3
552.2
568
568
614
537.3
537.3
552.2
552.2
552.2
552.2
568
568
614
614
614
614

Minimum Relative Abudance [%]

in a CSV document:

and in an HTML file:

5
RT [min]
1.28
1.96
1.4
2.66
1.76
4.24
4.66
3.2
3.48
4.46
4.5
3.94
4.14
3.22
3.66
3.9
4.2

Mgears MSScan Results

Parameters

Paramater
Results Directery
Started On

Completed On

Value

10
Total Rel Area [%]
10.09
70.13
0.84
0.3
16.77
0.14
0.15
0.11
0.08
0.13
0.07
0.05
0.42
0.16
0.24
0.19
0.12

Minimum Area Threshold [%]

Rel Area [%] Abs Area Rel Height [%]

100
100
73.99
26.01
100
48.38
51.62
28.65
20.34
32.63
18.39
10.94
89.06
22.79
33.14
27.11
16.96

CiUsers/Usuario/Deskiop/Results/MS Scan/2021-03-12709.59.15

2021-03-12T09:59:18

2021-03-12T09.59:20

14523
100985.5
1216
427.5
24147.5
198.112
211.4
162
115
184.5
104
75
610.5
234.5
341
279
174.5

100
100
58.06
41.94
100
49.36
50.64
17.4
18.62
24.41
39.56
50.08
49.92
25.58
31.82
21.87
20.73

Minimum Relative Abundance 5%

Tolerance 0.25Da

Minimum Area Threshald 10,00 %
Detailed Results

Show 100 -~ entries Copy ©CSV  Columns PDF  Print Search:

Output csv 4 Qutput mnova mfz [Da] RT [min] Total Rel Area [%] Rel Area [%] Abs Area Rel Height [%]
MSScanResults_SMPL1.csv  SMPL1.mnova S537.3000 1.28 10.09 100.00 14523.000 100.00
MSScanResults SMPL1.cev  SMPL1.mnova 5§52.2000 1.96 70.13 100.00 100985.500  100.00
MSScanResults_SMPL1.csv  SMPL1.mnova S68.0000 1.40 0.84 73.99 1216.000 58.08
MSScanResults_SMPL1.csv  SMPL1.mnova 568.0000 2.66 0.30 28.01 427.500 41,94
MSScanResults_SMPLA SMPL1.mncva 614.0000 1.76 16.77 100.00 24147.500 100.00
MS5ScanResults_SMPL1.csv  SMPL1.mnova S37.3000 4.24 0.14 48.38 188.112 49.36
MSScanResults_SMPL1.csv  SMPL1.mnova 537.3000 4,66 015 51.62 211,400 50.64
MSScanResults_SMPLi.csv  SMPL1.mnove 552.2000 3.20 0.11 28,65 162.000 17.40
MSScanResults_SMPL SMPL1.mnova 552.2000 348 0.08 20.34 115.000 18.62
M3ScanResults_SMPL1.cs SMPL1.mnova 552.2000 4.46 0.13 3283 184500 2441
MSScanResults_SMPL1.cs SMPL1.mnova 552.2000 4.50 0.07 18.39 104,000 30,56
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Each row in the CSV and HTML reports represents an extracted chromatogram peak with its m/z, RT, and Total
Rel Area (%). Rel Area (%), Abs Area, and Rel Height (%) are also displayed for each peak, as previously defined
in the plugin settings in this example.

You will also find links to the CSV and Mnova results in the HTML report.

The advantage of this type of report is that it allows you to change the display of the Columns and adapt them
to your preferences, then Copy, Print, or save your results into CSV or PDF format.

Copy CSV  Columns PDF Print

m/z [Da] RT[ Output csv

Output mnova

537.3000 1.28
m/z [Da]

552.2000 1.96 RT [min]
Total Rel Area [%]

Rel Area [%]
568.0000  2.66 |[EFYRNENN

568.0000 1.40

614.0000 176 [EAARRELIED

3. Results review with the Mgears Viewer

MS Scan is compatible with the Mgears Viewer, which allows you to review your results. Start this example by
opening the Mgears Viewer from the Tools section in Mnova:

(Sor h=i s MestReNova MASS
File Home View Molecule Prediction Data Analysis Database Verification Elucidation Chemometrics Tools Analysis Quantitation
5@. ¥ = A '3 @ - s
y EREELE v & f N2 (] @ @ B3
® Vi o) GRS M \~ ) @ B
Chemical Shift ~ Edit Run Stop  Import Export Report Loaded NMR  Mgears |Mgears [MyGears MyGears Reaction Mnova Mnova  View Mnova
Perturbation ~ Script = Script » Script - v v Scripts Tools « i Workflows Monitorings Screen 1H Screen 19F Screen Result
Binding Scripts Script Tools Mgears Reaction Monitoring Screen

Click on L and select the MS Scan analysis output folder.

Mgears Viewer

wleO ¢|@|@r|
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The experiment results will be loaded in the Mgears Viewer dialog. Select a sample in the table or well plate.
The detailed results will appear in the Results section, and the corresponding Mnova document will open.

Mgears Viewer g %
' B
I ¥ .
. Il_l @ D a @B% A;al\{fze
gain
# Title Document Location el
1 SMPL1 SMPL1.mnova  C/Users/Usuario/Desktop/Results/MS Scan/2021-03-12T09.5¢
2 SMPL2 SMPL2.mnova  C:/Users/Usuario/Desktop/Results/MS Scan/2021-03-12T09.5€ «
| | »
Results
MS Scan
Settings
Mass Spectrum Extraction Mass Chromatogram Extraction

Minimum Relative Abundance : 5 % Tolerance : 0.25 Da Minimum Area Threshold : 10 %

Results
RT ranges: from 1 to 3 min -
m/z: [EIC 2: 552.2000 Da [~]
m/z [Da] RT [min] Total Rel Area [%] Rel Area [%) Abs Area
1 552.2000 1.96 70.13 100.00 100985.500
Kl >
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In the Results section, you can select the RT range and m/z you want to inspect. Detailed results are displayed
in the table below, and the corresponding extracted-ion chromatogram (EIC) plot is set as active in the Mnova

document.
Mgears Viewer 8 x
. %
V'._ I-—I @ D Q’ EEE AAr\aly'ze
gain
# Title Document Location [l
1 SMPL1 SMPL1.mnova  C:/Users/Usuario/Desktop/Results/MS Scan/2021-03-12T09.5¢
2 SMPL2 SMPL2.mnova C:/Users/Usuario/Desktop/Results/MS Scan/2021-03-12T09.5¢ +
4 »
Results
MS Scan
Settings

Mass Spectrum Extraction

Mass Chromatogram Extraction

20000

700004 30.15%

4000

Analysis results
GEARS
C:\Users\Usuar...C\SMPL1\MSD 1.MS Injedtion 1 Function 1 (1000) TIC
19607,
1753 |
ol -
101214 1618202224 2628 3.03.2343.63.8 40424446485,

Retention time (min)
C:\Users\Usuar...C\SMPL1\MSD 1.MS Injection 1 Function 1 (1000) MS + spectrum 1.

614.000
36.76%

552
537300 100.00% 568.000

15.76%

535 540 545 550 555 560 565 570 575 580 585 590 595 600 605 610 615 62
m/z (Da)
Ci\Users\Usuar...C\SMPL1\MSD 1.MS Injedtion 1 Function 1 (1000) EIC 537.3 Da
1278

00.00%

1.0 1.2 14 1.6 18 2.0 2.2 2.4 2.6 2.8 3.0 3.2 3.4 3.6 3.8 4.0 4.2 4.4 4.6 4.8 51
Retention time (min})

C:\Users\Usuar...C\SMPLI\MSD 1.MS Injection 1 Function 1 (1000) EIC 552.2 Da
20000 1360
100.00%|

0 ‘L - B

1.0 1.2 1.4 1.6 1.8 2.0 2.2 24 26 2.8 3.0 3.2 3.4 3.6 3.8 4.0 4.2 4.4 4.6 4.8 5.
Retention time (min)

Mini Relative Abundance : 5 % Tolerance : 0.25 Da Minimum Area Threshold : 10 %
Results
RT ranges: from 1 to 3 min
A= EIC 2: 552.2000 Da
i EIC 1: 537.3000 Da |
m/z [Da] RT [min] Tota ME1C 2: 552.2000 Da Abs Area
- 1 552.2000 1.96 70.13 EIC 3: 568.0000 Da 100985.500
EIC 4: 614.0000 Da
L4] ]

C:\Users\Usuar...C\SMPL1\MSD L.MS Injedtion 1 Function 1 (1000) EIC 568 Da
1.398

79 s ha M A |
2701 A A M~ A l,wa.‘f.wmr,mwiﬁ_uk.»\“lll
M ] W AN v v

180

1.01.214 161820222426 283.032343.63.84042444.6485
Retention time (min})
C:\Users\Usuar...C\SMPL1\MSD 1.MS Injedtion 1 Function 1 (1000) EIC 614 Da
1

Retention time (min)

You can review your results, change peaks colors, etc., using the standard tools from Mnova, then save the

changes by clicking on Save H

Note that, in this version of MS Scan (1.0), the Analyze Again option is not available, therefore a recalculation

cannot be performed.

For more details on the Mnova Gears options, please refer to the Mnova Gears manual.
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